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Audit Trail 
 

Starting with version 4.40 Hydras 3 can automatically generate a so called audit trail which logs 

important user actions in an encrypted archive. 

Among these relevant user actions are e.g. creating stations/sensors, editing data or 

starting/stopping jobs. 

Logging to the audit trail is by default inactive for all Hydras 3 instances. It can be explicitly 

activated/deactivated in the options dialog (F2) on the “General” tab sheet with the “Log important 

actions in an audit trail” checkbox. This checkbox is only visible for user accounts that have 

permission to write to the LOCAL_MACHINE section of the registry. 

If the audit trail option is activated on a Hydras 3 net server, all important client actions on 

workspaces of this server are logged, independently of this option on the client side. 

To view the audit trail the menu item “Extras > Audit Trail” has to be selected (not available for 

Hydras 3 Basic). This opens the audit trail viewer as shown below, where in a list view all audit trail 

entries are displayed that meet the filter criteria: 

 

 

There is a variety of filters available to show only specific parts of the audit trail. There is a separate 

audit trail available for each workspace which can be selected in the workspace combo box. If no 

workspace is selected (“---“) then only audit trail entries that are not workspace specific will be 

displayed, e.g. modifying global options. 

The time range filter is used to filter out user actions that occurred in the specified timerange. 

The data time range filter is used to filter out user actions that occurred in a specific timerange of the 

affected data, e.g. when editing or validating data in a specific time range. This filter can only be used 

when the additional object filter is set to either DATA or INFODATA. 

With the filter option “Stations in selection list” only log entries associated with stations in the 

selection list will be displayed. 

The filter option “Sensor number” is used to show only entries of sensors wih the specified sensor 

number. 

To show only log entries of a specific user the “User name” edit filled can be used. 

With the “Action” combobox the type of the action (e.g. Create or Delete) can be defined and with 

the “Object” combobox the object of an action (e.g. a Station or a Job). 

If multiple filter criteria are active then ALL criteria must be fulfilled. 
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Double-clicking on an list item of the audit trail will show a corresponding window associated with 

the logged action. For example double-clicking a DATA action will open the graph window showing 

the affected time range or double-clicking a JOB action will open the job configuration dialog. 

In the graph window the inverse action is available, which allows to show audit log entries that are 

related to the displayed time range of a sensor. Use the “Extras > Audit Trail” menu item in the graph 

window to open the audit trail window showing the DATA actions that are related to the displayed 

time range. 
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Automatic check of redundant sensors 
 

Hydras 3 has since long time the capability to verify the correct operation of a sensor by comparing 

its values to a redundant sensor (details can be found in the Hydras 3 online help). However the 

automatic comparison between these sensors was only triggered after the automatic reading of a 

station or by the explicit execution of the CheckRedundantSensor script command.  

With version 4.40 of Hydras 3 the user can define the interval in which the comparison is made 

individually per workspace. 

This can be done in the redundant sensors window, which is displayed by selecting the menu item 

“Extras > Redundant sensors” in the Hydras 3 main window. 

 

 

In the list view all sensors that have a redundant sensor are displayed. 

When a sensor is selected, the settings of the automatic check for the corresponding workspace are 

displayed on the right side of the window. With interval and offset the time of the check are defined. 

Click “Save” to save the settings. 

Please note that at the configured times, the check will be made for all monitored sensors of the 

workspace. 
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Image archive for webcam images 
 

The Hydras 3 net server can receive and store webcam images sent from dataloggers that are 

connected to a webcam. However so far only the latest image was saved and could be displayed. 

With version 4.40 the Hydras 3 net server can archive the received webcam images for a configurable 

period and offer a list view to browse and view the saved images. 

Archiving of webcam images has to be activated explicitly in the options dialog (F2) on page “Hydras 

3 net”. The archived images will be automatically deleted after a configurable period (max 30 days). 

The image files are saved in the “Images/Archive” subfolder of the corresponding station folder 

(which itself is within the workspace folder). For each day a new subfolder is used. 

Shown below is the “Image” section of the “Monitoring network” feature set of Hydras 3 net.  

By dragging and dropping stations in the list view, the connected webcam devices are listed and the 

latest image can be displayed by clicking on the list item. 
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With Hydras 3 net 4.40 the additional tab sheet “Image Archive” is available to browse the archive of 

received webcam images as shown below. 

 

 

 

Select the timerange for the images and click “Refresh” to list all images of the currently selected 

station/webcam in this range. Selecting an timestamp in the list shows the webcam image at this 

time. 
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Displaying the latest webcam image or a specific one in a timerange is now also supported in the 

Hydras 3 net web interface.  

The “Images” tab sheet is available as part of the “Monitoring network” page (see below). 
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Check for new Hydras 3 version 
 

Hydras 3 can now check if new updates on our webpage are available for download. 

This check can be done manually or (as an option) automatically at each at startup. 

A manual check is initiated by selecting the menu item “Help > Check for updates” in the Hydras 3 

main window. 

The check might take a couple of seconds and after a while a window is displayed with the result of 

the check (see below). 

 

 

 

If a new version is available, the version number is displayed and a button which opens a browser 

window with the download page for the new version (if clicked). 

By default, the option to to automatically check on startup for a new version is deactivated. 

To change this option, simply start a manual check and click in the checkbox of the result window. 
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Configurable dashboards for web interface 
 

Starting with V 4.40.0 Hydras 3 comes with configurable dashboards for the web interface. 

These dashboards can be accessed by clicking on the “Dashboard” link in the navigation bar. 

Each user can configure up to 5 different personal dashboards. To switch between the different 

dashboards, click on the panels labelled “1” to “5” in the dashboard navigation bar.  

Each dashboard consists of a number of dashboard panels with configurable position and size and 

different content types. Below is an example of a typical dashboard comprising different panel types: 

 

 

Creating and editing a dashboard panel 
Initially each dashboard comprises 4 empty dashboard panels. 

To create a new panel click on the “Add Panel” button in the dashboard navigation bar. 

To edit a panel click on the edit icon ( ) in the panel header, which becomes visible when the 

mouse is moved over the panel. 

Both actions show the panel dialog in which the detailed settings of the panel are configured. 

Each panel has a title and a type. The titel can contain a fixed text or you can use the tags <STATION> 

and <STATIONID>, which are replaced at runtime with the name or ID of the current station. 

The type defines what kind of information is displayed in the panel. Each type has different settings 

that are explained in detail in the next section. Click OK to save the settings for a panel and to return 

to the dashboard view. 

To remove a panel from a dashboard click on the trashcan icon ( ) in the panel header. This action 

has to be confirmed in a browser dialog. 
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Panels can be interactively moved on the dashboard by dragging and dropping the panel around. 

Click on the panel title in the header to move the panel. The other panels will automatically adjust 

their position when moving a panel. While the horizontal position can be arbitrarily chosen, the 

vertical position will be automatically adjusted so that gaps above the panel will be avoided. 

To change the size of a panel click on one of the arrow icons in the panel header that are shown 

when the mouse is over the panel. The right arrow is used to increase the horizontal size while the 

left arrow decreases it. The down arrow is used to increase the vertical size while the up arrow 

decreases it. After changing positions and/or sizes of the panels click on “Save Settings” in the 

dashboard navigation bar to save these changes! 
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Paneltypes 
Hydras 3 net offers a variety of paneltypes for dashboards. These paneltypes are explained below in 

detail. 

Linechart 

This panel type displays the values of one or more sensors as a line chart. 

 

The window below shows the settings of a line chart panel: 
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With the value type the kind of displayed data can be defined. These options are available: 

• Measured Value 

• Hourly Mean 

• Hourly Total 

• Daily Mean 

• Daily Total 

The total values are especially useful to displayed accumulated precipitation intensity. 

In the tree view at the bottom of the page the sensors to be be displayed in the chart are selected. If 

multiple sensors are selected the option “Multiple y-Axes” can be activated so that every sensor has 

its own value axis. If this option is not ative than the axis of the first sensor is used as a common axis 

for all sensors. 

With the option “y-Axis Autoscaling” the value axis (or multiple axes if selected) is automatically 

scaled so that all displayed values are visible. If this option is not active, the axis range from the 

sensor properties is used. 

Finally the displayed time range has to be configured.  

Barchart 

This panel type displays the values of one or more sensors as a bar chart. 

 

 

 

The settings are exactly the same as for a line chart. 
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Table 

This panel type displays the values of one or more sensors in a table. 

The only configurable options are the sensors to be displayed and the time range. 

 

 

Current values 

This panel type displays the current values of one or more sensors in a table. 

The only configurable option are the sensors to be displayed. 

 

 

 

Status 

This panel type displays the network status as a bar chart. This is (almost) the same chart as in the 

“Monitoring network” page. No additional settings are required. 
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Webcam 

This panel type displays the latest image of a webcam. 

 

 

In the configuration dialog all webcams that are connected to a station are listed. 

 

Click on a list item to show a preview of the latest image of this webcam. 
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Map 

This panel type displays the map view of the stations. 

Moving the mouse over a station marker will show the current value of that  station. 

 

The only option of the map panel is the “Click Mode”, which defines what action is taken, when a 

mouse click is made on a station marker. When mode “Show dashboard for clicked station” is selected, 

then a mouse click on a station marker in the map loads the same dashboard page but uses the clicked 

station for all panels. This has the same effect as selecting a station in a “Station selection” panel (see 

further below). 

 

URL 

This panel type displays the content of a file which is specified by its URL. 
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In the example panel above a Hydras 3 script running on the same Hydras 3 net server, that serves the 

dashboards returns the current time respectively a simple HTML table. 

 

 

 

For security reasons the content that is delivered by the URL must be plain text or HTML without 

JavaScript. To reference an image from a URL use the “Image” panel type described in the next section. 

For security reasons no content from other servers can be referenced in the URL panel. 

 

Image 

This panel type displays the content of an image file which is specified by its URL. 

 

 

For security reasons no content from other servers can be referenced in the Image panel. 

 

Gauge 

This panel type displays the current value of a sensor as a gauge. The current value is the value with 

the most recent timestamp that was written to the database. 
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In addition to the station/sensor that is displayed, different boundary values (0-3) that mark green, 

yellow and red gauge ranges can be defined. 

 

 

Value 0 is the lowest value of the gauge scale (begin of green range). 

Value 3 is the highest value of the gauge scale (end of red range). 

Value 1 defines the boundary value between the green and yellow range. 

Value 2 defines the boundary value between the yellow and red range. 

 

With the option “Inverted” the order of the ranges can be inverted, so that the red range starts with 

value 0 and and the green range ends with value 3. 

By setting multiple boundary values to the same value, the number of ranges can be reduced. 
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For example to define only two ranges from 0 to 30 (green and red) with boundary at 15 these settings 

are used: 

 

Value 0:  0   

Value 1: 15 

Value 2: 15 

Value 3: 30 

  

 

Windrose 

This panel type displays a windrose chart showing windspeed and winddirection in a polar diagram. 

In the configuration dialog the wind speed and wind direction  sensors (and station) must be selected 

as well as the time range for the display. 
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Windrose with categories as displayed below: 

 

 

Meteogram 

This panel type displays data of multiple sensors of a weather station in a so called meteogram as 

shown below: 

 

A meteogram uses different visualization types depending on the displayed parameter type of a 

sensor. 

Precipitation intensity is displayed at the bottom of the diagram as bars. 

Wind speed and direction are shown as small arrows below the actual chart, with a circle indicating 

(almost) no wind. 

 The METAR weather code is displayed as a small weather icon at the top of the meteogram. The 

METAR weather code can be provided e.g. by a Parsivel as a numeric value. 
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In addition to these specific parameter types two sensors of arbitrary type can be displayed as line 

charts in the meteogram. These sensors are labelled “Sensor 0” and “Sensor 1” in the configuration 

dialog (see below). 

In the meteogram shown above, the air temperature and the relative humidity is used for these 

arbitrary sensors. 

 

Finally, the time range for the meteogram has to be defined. 

 

Station selection 

This panel type can be used to select a specific station for which the panels of the current dashboard 

shall be displayed. The only configurable option is the station that is initially selected when the 

dashboard is displayed. 

 

 

Normally all dashboard panels except status, map, URL and image are referencing data or images of a 

fixed station. 
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In cases where dashboards shall be used to display data or images of any station, a “Select station” 

panel must be added to the dashboard. When such a panel is part of the currently displayed 

dashboard, all station references of the panel are set to the selected station. 

Changing the selected station results in re-loading the dashboard and showing data or images of the 

selected station.  

 

Heatmap 

This panel type displays data of a sensor in a so called heatmap, which is a 2-dimensional grid 

showing different sensor values as different colors in the grid. 

In the configuration dialog the sensor has to be selected, the heatmap type and the time range to be 

displayed. 

There are 2 different types of heatmap: 

Compare days 

This heatmap type displays individual measured values as colors in the grid. The horizontal axis 

shows the days in the selected time range, while the vertical axis shows the time within a specific day 

(00:00 – 24:00 [excluded]). 

This heatmap type allows to compare different days in the specified time range. 
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Compare Years 

This heatmap type displays aggregated daily values (mean or total) as colors in the grid. The 

horizontal axis shows the days of a year (begin of January until end of December), while the vertical 

axis shows the years in the selected time range. 

This heatmap type allows to compare different years in the specified time range. 

Daily totals can be used to compare precipitation values. 

 

 

 

 

Embedding dashboard panels in a external webpages 
 

The different dashboard panel types explained above can also be embedded in external webpages. 

This is explained in detail in a separate document, which is available upon request from OTT Hydromet. 
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Download Meteosat data from Eumetsat server 

 
Hydras 3 net allows starting with version 4.22.0 to download data automatically from the Eumetsat 

webserver that were transmitted via Meteosat satellites in SHEF format using either OTT netDL or 

Sutron SL3 data loggers. 

To perform this automatic download a Meteosat download job has to be created. 

This is done in the job manager (main menu “Extras > Job Manager”) using menu item “File > 

Meteosat download jobs”. Selecting this menu item will show a list of already created jobs. Initially 

this list is empty and a new job has to be created by clicking the “New” button, which will open the 

job configuration dialog show below: 

 

 

 

In the jobname field a name for the job has to be defined. 

The workspace to which the data will be transferred is selected using the workspace combo box. 
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The timestamps of the data in the messages are calculated based on the transmission time which is 

in UTC. If the UTC time shall be converted to local time, this checkbox has to be checked and the 

offset to UTC selected. 

The job runs at configurable intervals or fixed times, which can be configured by clicking on the 

“Configuration” button. A reasonable setting here typically is to execute the job every 30 or 60 

minutes. 

With the “Autostart” option, the job will automatically be enabled and scheduled by the job manager 

directly after Hydras 3 is started. This option should normally be checked. 

If the “Import data in Hydras 3” option is activated, data extracted from the satellite messages will be 

directly transferred in the corresponding sensor databases in Hydras 3. 

The extracted data can also be saved in MIS format, a simple text based format to a configurable 

folder, where the data can be further processed by 3rd party software. 

To retrieve data from the Eumetsat webservice from the usual server service.eumetsat.int, an 

account with username and password is required. These credentials have to be entered in the text 

fields. 

By clicking on the “Test button” the correctness of the server credentials can be checked. 

Finally, a list of stations has to be configured, for which data shall be retrieved from the Eumetsat 

server. These stations are added to the list in the dialog window by dragging and dropping them from 

the tree view in the Hydras 3 main window. Only stations from the selected workspace will be 

accepted. 

As the Eumetsat server does not know about Hydras 3 Station-IDs, but requires Platform- or DCP-IDs, 

a one-to-one mapping between these two ID types is required. 

When importing a binary netDL or a text based SL3 configuration file using “File > Import station 

configuration”, Hydras 3 will automatically extract the Platform ID from the configuration and store it 

in the Hydras 3 station configuration in the “Variables” section, as shown below: 
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If stations are setup manually in Hydras 3, the entry PLATFORMID=… must be added manually to be 

able to retrieve data from the Eumetsat server. 

The Hydras 3 Meteosat download job can only handle messages containing SHEF format. 

If these SHEF messages are generated by a Sutron SL3, the measurement labels of the SL3 are also 

used as labels in the SHEF format. If these labels are longer than 4 characters, they must be mapped 

to 4-character alphanumeric Hydras 3 sensor-IDs. Hydras 3 does this automatically by cutting of 

anything longer than 4 characters. However, this might lead to undesired results, as e.g. the 2 SL3 

labels RainRt and RainAcc would both be mapped to the same 4-character sensor-ID “RAIN”. 

Hydras 3 offers a simple way to define this mapping explicitly using a text file named 

“SutronLoggerLabelMap.txt”. This file can be placed either in the Hydras 3 application folder or 

individually in workspace folders. If it is found in a workspace folder, it will be used for all sensors in 

this workspace. If it is not found in the workspace folder, Hydras 3 will check in the application folder 

and if available use it from there for all workspaces that do not have an explicit file. 

Each line in this file defines a mapping from a SL3 measurement label to the corresponding Hydras 3 

sensor-ID (plus an optionally appended sensor name for creating these sensors with proper names in 

Hydras 3 when such a station is created automatically in Hydras 3 by importing a SL3 configuration 

file). 

Example: 

RainRt=RARTRain Rate 

RainAcc=RAACRain Accumulated 

The first line maps the SL3 label “RainRt” to the 4-char sensor-ID “RART”. All characters after the 4-

char sensor ID are used as the name of the sensor (“Rain Rate” in this case).  
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Updating Python scripts in Sutron Xlink 500 and SatLink 3 
 

To update a Python script in Hydras 3 net drag&drop the station node in the station list on the 

configuration tab sheet. Selecting the station in the list will show the history of station configuration 

files in the list on the right. 

 

 

 

Select the latest configuration configuration file on top of the list and right click to bring up a popup 

menu. Select “View/Edit in Hydras 3 net”, which will open the configuration file in a window as 

shown below. 

 

 

 

In the text field at the top the actual configuration file is shown, while at the bottom a Python script 

can be added or an existing one edited.  

To send that file to the corresponding Xlink or Satlink, save it and confirm in the dialog that you want 

to create a command so that the logger will download that configuration file and apply it. 
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If you click on “Save As” the file can be saved with a different filename. If you save it on the server in 

the same path as the original file, you can also create an update command. If you do a  “Save As” on 

the Hydras 3 net client side, only the filename that you specifiy will be used, but the file will always 

be sent back to the server and saved in the config folder of the station. In this case you are also asked 

if you want to create an update command. 

Actually the whole content of the file (configuration plus Python code) is interpreted by the logger as 

command line commands. Hydras 3 net adds a !SCRIPT LOAD command directly after the actual 

configuration and before the Python Code. After the Python code a Ctrl-Z character is added to 

indicate the end of the script and then an additional command !SCRIPT SAVE is added, which is 

requried to save the script from RAM to Flash on the logger. 

 

Entering command line commands  
 

In case you want to send only some simple command line commands to the logger, you can select an 

XLink/Satlink station in the list, right click to open a context menu and execute the “Enter 

command(s)” menu item. 

This will open a simple text window, where you can enter the command or some lines of commands 

as shown below. 

After clicking on “Generate command” you have to confirm that you want to create the command. 

Hydras 3 net will then provide this command (or multiple commands) to the logger after the next 

data transmission and the logger will then execute these commands. 
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Security Enhancements 
 

Based on the results of different penetration tests, security of Hydras 3 net has been further improved. 

Setting up a Hydras 3 net server in the most secure way without breaking compatibility to the 

existing IT environment requires however some configuration effort and a deeper understanding of 

HTTPS communication. A separate white paper will be made available for administrators covering 

this advanced topic. 

 

Excel Export without OLE Automation 
 

Hydras 3 offered so far only an export to Microsoft Excel using so called OLE Automation, which 

means that Excel had to be installed on the Hydras 3 PC and was then started and data were directly 

written to a new Excel spreadsheet. 

With the new version 4.40 Hydras 3 can now directly create an XLS Excel file without the need to 

have Excel installed on the PC.  

This is available in the graph window with meu item “Extras > Export > Excel file (.xls)”. 

In the multi column export dialog the button “Export .XLS” is now available for direct file export. 

 

Import of Sutron Xpert2 and Xlite 9210 configuration files (SSF) 
 

Hydras 3 can now import SSF configuration files of Sutron Xpert2 and Xlite 9210 data loggers. 

To create a station in Hydras 3 based on the SSF configuration file, use menu item “File > Import station 

configuration (XML|BIN)” in the Hydras 3 main window. 


